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GENERAL INFORMATION 

 
Árido-Ciencia is a peer reviewed scientific journal that is published, edited and distributed 

every six months by the Jorge Arturo Alba Avila Herbarium (JAAAH) and researchers from the 
academic group under consolidation called "Richness, Interactions and Biodiversity Conservation" of 
the Lines of Knowledge Generation and Application (LKGA)"Biology, Vulnerability and 
Conservation of Flora, Fauna and Wild Microbiomes "of the Faculty of Biological Sciences at the 
Juárez University of Durango State. The journal covers topics concealed in Biosciences and 
Ethnodiversity, therefore intermediate topics between both areas can be submitted for 
publication. 

 
The manuscripts can be submitted in either Spanish or English. If translation to or from English is 
required, the journal has a Department of Foreign Language Communication (with TOEFL ITP, 
BRITISH COUNCIL, IELTS and INTERNATIONAL HOUSE certifications for English 
language) that can provide the translation service for a minimum recovery cost per page.  
 
Árido-Ciencia considers that the content of the contributions is of full responsibility of the authors, 
so the journal, editorial group and the academic affiliations of the national and international editorial 
group are exempt from any liability in this regard. 
 

TYPES OF PUBLICATIONS 
 
Árido-Ciencia considers scientific articles, notes (Short communication), reviews (Reviews) and 
semblances (Semblances) for publication as long as these have not been submitted for publication in 
other editorial bodies and are not simultaneously submitted elsewhere. 
 
Scientific article. -Those unpublished extensive works that fit between the two main topics of 
the journal: Biosciences and Ethnodiversity (Examples: Ecology, Taxonomy, Herpetology, Plant 
Ecology, Molecular Biology, Entomology, Biogeography, Ethnosciences and all others related to 
these subjects) are taken into consideration. 
 
Short communication. - Are those studies of short observations, unusual findings or preliminary 
research of complex studies that allow for the contribution of new knowledge or hypotheses for 
future research. 
 
Short note in ethnobiodiversity. - A note in ethnobiodiversity refers to all reports of 
ethnospecies, which is understood as the entity constituted by a biological species and its 
corresponding cultural (traditional) name. The note must describe the perception, knowledge or 
utilization of the ethnospecies, its socio-ecological relationship or the geographical region. 
 
Reviews. - Topics of current interest for science based on gathering the most relevant information 
on specific topics. In comparison to research articles, reviews are general, selective and completely 
critical analyses integrating essential information into current topics carefully. 
 
Semblances. - Biography of limited extension in which information about the work and human 
career of outstanding people in the scientific research field is presented to recognize such trajectory. 
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GENERAL PROCEDURES FOR THE PREPARATION 
OF CONTRIBUTIONS 

 
Preparation of the text: Double-space in Word 97-2013 processor, font type Times New Roman 
with 12 points of size, margins of 2.5 cm, continuously numbered pages and lines at the left margin. 
The text must be written in the third person; numbers from zero to nine written with letters, except 
when preceded by some unit of measurement, and onwards from 10 with numbers. The units and 
abbreviations to be used are those accepted in the International Units System 
(http://www.sc.ehu.es/sbweb/fisica/unidades/unidades/unidades.htm). 
 
Titles of the manuscript: A main title in Spanish and English must be included in capital letters, 
bold and centered, with a maximum of 15 words. A short secondary title that will be used as a ledge 
and should be written in the original language of the manuscript with upper and lower case letters, 
aligned to the left and with a maximum of seven words. 
 
Authors and addresses: Complete names, starting with first name (s) followed by last name (s). 
The co-authors separated by comma and at the end of each it must include superscript numbers for 
identification. Each number will indicate the author’s adscription. If there is an author for 
correspondence, indicate it with an asterisk and at the end of the adscriptions add the legend 
"Author for correspondence: indicating the contact email”. 
 
Summary: In the language opposite to the body of the manuscript, include five keywords in both 
languages respectively. Keywords should not be contained in the main title. 
 
Margins: 2.5 cm wide in all four sides. 
 
Tables and Figures: Include these immediately after the cited literature in the order of appearance 
throughout the text. They must be respectively numbered in Arabic, fully readable, direct, clear and 
with bold font. The caption in the case of the tables is placed above while in the case of the figures, 
photos or diagrams is placed below. These must be sent in separate pages at the end of the text (See 
annex I). 

MATERIALS AND METHODS 
 
Experimental design: A detailed description of the experimental design begins in this section. 
 
Main and secondary titles within the manuscript body: The main titles are used for the 
separation of sections contained within the manuscript and these are aligned to the left, in bold font 
and capital letters without full stop mark. Its corresponding description begins in the next line. 
Secondary titles account for each section and are aligned to the left side in bold italics using both 
uppercase and lowercase, full stop mark, and followed by the corresponding wording. 
 
Literature cited within the text: At first indicate the surname of the first author followed by that 
of the second author or ‘et al.,’ followed by the year of publication as shown below: (Márquez, 
1992), (Muro & Leyva, 1993), (Sánchez et al., 1994; Muro & Leyva, 1993). If there were more than 
two authors adjust as follows: Estrada-Castillón, E, Villarreal-Quintanilla, A.J. & E., Jurado, 2011. 
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DETERMINED FORMATS FOR CONTRIBUTIONS 

 
SCIENTIFIC ARTICLES AND REVISIONS (Reviews) 

 
SCIENTIFIC ARTICLE 

 
Layout. - The order is defined as follows: short title, main title in Spanish and English, author (s), 
abstract and keywords in Spanish and English, introduction, methodology, results, discussion, 
conclusions, acknowledgments (optional) and cited literature. 
 
Abstract. - An extension of no more than 250 words including research question, justification, 
methodology, relevant results and conclusion. All of the above in a single paragraph without 
citations. 
 
Keywords. - A maximum of five keywords not included in the title. They must be sorted 
alphabetically and separated by semicolons. If necessary, include compound keywords (Ex: 
Thermal Ecology, Applied Botany). 
 
Abstract and keywords (in English). - It must contain exactly the content of the abstract and 
keywords that are in Spanish. The authors are fully responsible for the English translation. 
 
Introduction. - Emphasize precisely on the importance, justification, background and objective (s) 
of the investigation. Add the related bibliography from the last five years. In case that there is a 
poorly developed topic, the inclusion of classic bibliographies on the subject from more than five 
years can be considered. If possible, omit the use of thesis information (undergraduate, master's and 
doctorate); however, if necessary, only a maximum of two citations of this type will be accepted, 
preferably of the maximum degree. 
 
Materials and Methods. - If you have done fieldwork, provide a description of the study area, it 
may include a map. It is important to detail the materials used, specifying where, when and how the 
methodological process of the study or experiment was performed. Emphasize on the experimental 
design, evaluated variables and statistical analysis applied. If databases or other relevant 
information is considered, mention it. In addition, if the investigation included the collection, 
capture or manipulation of any organism, attach the pertinent information regarding collection 
permit to carry out such activity and add data about the placement of biological material in 
scientific collections. 
 
Results. - These should be direct, highlighting important aspects only related to the research. They 
must be presented in an objective way using tables, images, figures and / or graphics (see ANNEX I 
TABLES, IMAGES AND GRAPHICS) avoiding their unnecessary. Graphics referring to a 
statistical result must be displayed in black and white or gray scale when required. 
 
Discussion. - In this section the interpretation of the results from other authors will be performed, 
which will be compared to those obtained in the research itself. This could substantiate the 
authenticity of the investigation by presenting a logical argument based strictly on related works 
and the stated hypothesis in case it was this way. 
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Conclusions. - It should be taken into account that this is where the novel scientific contributions 
are presented, which are conceived as a direct logical deduction of the developed research; 
therefore, these must be congruent, direct, logical, strictly limited to the research and without 
similar connotation to results. 
 
Acknowledgments. - These should be brief and emphasizing primarily the institution (s) that 
provided support for the development of the research, as well it should include project or support 
number and the period if applicable whenever possible. Also, include the name of the group that 
supported its development if required. 
 
Literature Cited. - It must contain a complete list of all the information used and presented in 
alphabetical order. This section also considers online or printed sources. For ease of use it is 
recommended use the following free license manager 
(http://www.cva.itesm.mx/biblioteca/pagina_con_formato_version_oct/apa.htm) to generate 
literatures in APA format from: books, magazines, newspaper, encyclopedias, web pages and 
journals. 
 

SHORT COMMUNICATION 
 

As a note, all the information that the Internal Editorial Committee and the referees consider should 
be published under this modality. This modality will include preliminary results, records of new 
locations for species with ecological or other type of importance, records of new species and new 
methodologies proposed for the field of science. The note must include a title of no more than 15 
words (Spanish and English), abstract of maximum 150 words, five keywords (abstract and key 
words in Spanish and English), introduction, and advance of the topic with sub-topics defined by 
the authors, results, discussion, acknowledgments and cited literature. The note must not exceed 15 
pages. 
 

SHORT NOTE IN ETHNODIVERSITY 
 

A note in ethnodiversity considers all that record of ethnospecies, which is therefore the entity 
constituted by a biological species and its corresponding cultural (traditional name). The note must 
describe the perception, knowledge or use of such ethnospecies, its socio-ecological relationship or 
geographical region. This note is composed of relevant ethnobiological information, but insufficient 
to comprise a short note. This modality should focus on ethnobiological observations, provide new 
information that has not been previously reported and mentioned for a certain ethnospecies. It 
should be structured as follows: a) Title: must include the scientific name of the species and its 
traditional name. Author / s: based on the general specifications of Árido-Ciencia. Keywords: three 
words not included in the title. Introduction: Summarized. Material and Methods: Brief description 
of how the information was obtained in addition to the recording site, describe the place only with 
concise data (locality, municipality, state, country) and georeference. Results and Discussion: brief 
and concise, it is essential that bibliographic citations that support the discussion are included. 
Conclusions: not applicable. Literature cited: Minimum 3 and Maximum 5 citations, follow the 
general specifications of formatting. The extension of the ethnobiodiversity notes have a maximum 
length of one page, the note can be complemented with a photograph of the described ethnospecies. 
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REVIEWS 

 
The editorial committee will determine if a manuscript meets the criteria to be considered as such. 
This modality should include title (Spanish and English) of no more than 15 words, abstract, 
keywords (in both Spanish and English) and introduction. The rest of the sections that will shape 
the review may vary; however, it is necessary to add a section on the development of the topic, sub-
themes if necessary and which will be defined by the authors. A section of conclusions and cited 
literature should be added at the end. 
 

SEMBLANCE 
 
The internal editorial committee will determine if a document meets the requirements to be 
considered as such. This can refer to one or several people and are considered important regarding 
issues that contribute to the scientific labor, written in a formatting as memories, anecdotes and life 
stories about the person (s) to whom this is dedicated. Historical, posthumous or relevant 
professional achievements can also be published. Maximum extension of two letter-size pages using 
double-spaces. A half-lenght image of the person with a minimum resolution of 350dpi (equivalent 
to 8.5 inches) will be accepted in the center of the document. 
 

LITERATURE CITED SECTION 
 
The cited literature will be listed at the end of the contribution in alphabetical order. It is 
recommended to use the following free license manager 
(http://www.cva.itesm.mx/biblioteca/pagina_con_formato_version_oct/apa.htm) or Mendeley® 
(literature manager software) to generate citations in APA format from: books, magazines, 
newspaper, encyclopedias, web pages and journals (Fig. 1). The purpose of using Mendeley® is to 
ensure that references are properly organized content and related to the text. In the case of thesis,  
maximum of three citations will be accepted, considering that these are unpublished documents. 
 

 
Figure 1. Web portal display to generate cited literature in APA format. 
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Examples for other citations: 
 
Thesis (when necessary): 
Blanco Contreras, E. 1989. Inventario Florístico del Cerro de San Ignacio, Municipio de Gómez 
Palacio, Dgo. Tesis. Universidad Juárez del Estado de Durango, México. 47 pp. 
 
Multi-volume works: 
Britton, N.L. y Rose, J.N. 1963ª The Cactaceae: Descriptions and Ilustrations of Plantas of the 
Cactus Family. Vol. I. 2ª  ed. Dover. Nueva York, EEUU. 236. pp. 
 
Llorente-Bousquets,  J.  y  Ocegueda,  S.  2008.  Estado  del  conocimiento  de la biota.  En Capital 
Natural de México. Vol. I: Conocimiento Actual de la Biodiversidad. CONABIO. México pp. 288-
322. 
 
Statistical packages or Software: 
Kovach Computing Service. 1988. Multivariate Statistical Package. Anglesey, Wales, RU. 
 
Thematic Letters from National Institute of Statistics, Geography and Informatics (INEGI): 
INEGI. 2005. Carta de Uso Actual del Suelo y Vegetación. Serie III. Instituto Nacional de 
Estadística, Geografía e Informática México. (Cons. 10/03/2013). 
http://app1.semarnat.gob.mx/dgeia/informe_resumen/02_vegetacion/cap2.html  
 
Observation: it is suggested to cite articles current with the previous five years of publication 
(Example: in introduction, methodology and discussion). 
 

DOCUMENTS TO BE SENT FOR SUBMISSION OF A MANUSCRIPT 
 

1.- Letter addressed to the Editor in which the reasons for evaluation are exposed for possible 
manuscript publication, indicating that it is an original work that has not been submitted for 
publication in another journal nor is being submitted simultaneously to another journal; as well, it 
should be mentioned that there is no conflict of interest between authors. 
 
2.- Brief curriculum outline of main author and co-authors indicating academic degrees, 
institution where these were attained, current institutional affiliation. Prepare this item in the same 
language that the manuscript contains. Only the correspondence author should have a full postal 
address. Clearly indicate telephone and email for contact. The length of the outlines must be a 
maximum of one page. 
 
3.- List of three possible reviewers indicating their institutional affiliation, telephone and email. 
Yet, the editor and editorial body will consider this proposal and send the document to those 
specialists considered for evaluation. In addition, include a list of possible reviewers with whom 
there may be a conflict of interest to avoid considering them in the possible review. 
 
4.- Word file of the manuscript body with characteristics specified in the editorial standards. 
 
5.- The figures must be included at the end of the text and sent with a minimum resolution of 350 
dpi. 
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6.- The complete material must include the manuscript, tables, and / or figures as well as the 
respective caption of figures and / or tables. In the case of tables and figures send them in the same  
 
document, but at the end of the text. The caption should be placed above for tables while in figures, 
photos or diagrams underneath. They will be sent on separate sheets at the end of the text. 
 
7.- Letter of rights assignment in which the title of the contribution, author and co-authors will be 
indicated as well as an emphasis in the assignment of copyright to the magazine Árido-Ciencia: 
Biosciences and Ethnodiversity. This document must include the Full Name and Signature of the 
Author. The assignment of rights takes effect once the publication of the manuscript is accepted in 
the journal, otherwise its legal effect will be eliminated. 
 
8.- Send the documents to the official e-mail of the magazine: arido-ciencia@ujed.mx, since 
contributions will only be received through this means. 
 

EVALUATION TIMES 
 

1.- Arbitration. If the manuscript meets the editorial standards, time for the process will be 
approximately one month or less and will be notified by official communication (letter) issued by 
the editor. Contrariwise, if it is not accepted, it is also notified and the procedure is concluded. 
 
2.- Corrections of the manuscript. Once the contribution for publication has been accepted, the 
authors have 14 calendar days to make the adjustments proposed by the reviewers and possible 
observations made by the Internal Editorial Committee.  
 
3.- Final veredict. After making the corrections by the author and co-authors, the first galley proof 
is sent to the corresponding author so that, in the next 15 calendar days the respective modifications 
or adjustments requested are made. The authors will have seven calendar days for calling in and 
return the reviewed document to the Internal Editorial Committee. If no comments are received on 
the galley proof, the Internal Editorial Committee will notify the acceptance of the contribution for 
publication by official letter as a definitive article in an immediate issue close to release. 
 

COPYRIGHT 
 
Once the contribution has been accepted for publication in Árido-Ciencia, the authors accept the 
following agreements: 
 

a) The authors assign the rights to the journal to be the first agency to publish and distribute 
the   publication. 

b) The authors hold the copyright by being able to distribute, exchange, as well as share the 
contribution of Árido-Ciencia electronically under the terms that are best suited for the 
authors. 

c) Total content of the journal cannot be reproduced totally o partially under the term “no 
official copies”, since it only can be reproduced totally or partially if the documents are 
acquired from the official webpage www.aridociencia.mx. 
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PLAGIARISM AND FRAUD 

DETECTION 
 
In order to maintain the authenticity of the journal and the originality of the published intellectual 
material, the editorial board considers the pertinent procedures to ensure originality of the submitted 
intellectual material and avoid plagiarism or intellectual fraud, so in order to carry out this process 
following evaluation software is taken into consideration: 
http://copionic.citilab.eu/   
http://www.ithenticate.com/  
 
 
GENERAL CONSIDERATIONS ON THE INTERNATIONAL MEASUREMENT SYSTEM 
 
It is recommended to use those units established by the Legal Units of Measure in the process of the 
investigation, considering the units described in the following tables. Consult the following URL 
for those units not taken into consideration, 
http://www.sc.ehu.es/sbweb/fisica/unidades/unidades/unidades.htm: 
 

Basic units 
Magnitude Name Symbol 

Length Meters M 
Mass Kilograms Kg 
Time Second S 
Alternating current Ampere A 
Thermodynamic temperature Kelvin K 
Amount of substance mol Mol 
Light intensity Candle Cd 

 
 

Derived units IS dimension 

Magnitude Name Symbol Expression in basic units IS  

Flat angle radian rad mm-1= 1 
Solid angle stereoradian sr m2m-2= 1 

 
 

 

Derived IS units expressed from basic and supplementary units 
Magnitude Name Symbol 

Surface square meter m2 
Volume square cubic m3 
Speed meter per second  m/s 
Acceleration meter per  second square  m/s2 

Number of waves meter to output minus one m-1 
Mass by volume kilogram per cubic meter kg/m3 
Velocity angle radian per second rad/s 

Angle acceleration radian per  second square  rad/s2 
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ANNEX I 

 
FORMATTING FOR TABLES, GRAPHICS AND IMAGES 

 
Tables. They are included at the end of the text in the order they are presented throughout the 
manuscript and are listed consecutively. They must be sent in an editable format (Word or Excel). It 
is recommended not to over use them, so their use is only justified when the intention is to 
summarize some result or comparison of information. The titles of the tables are included at the top 
and it is recommended that the title and table are inserted within two lines of a 1X2 table. This 
option is found in the INSERT menu of the Table submenu (Figure 2) in text processors (Word). 
Once this table is shown, it will appear as two lines, the title (upper line) and the table (lower line). 
The format that will be accepted for the tables is CLEAR SHADING and is found in the TABLE 
TOOLS menu of the Design submenu. The text of the title must be in accordance to the general 
format of the contribution. 
 
 

TOP ROW  
Figure 2. Example of how to insert a 1 X 2 table.  

(BOTTOM ROW) 
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Graphics. The visual representation of the data by means of graphs is considered to detect patterns, 
trends and relationships. These can be columnar, pyramidal, linear, circular, bars, areas, dispersion, 
rings, bubbles and even the mathematical functions themselves. It is imperative that the graphics, 
whether bi or three-dimensional, contain the following basic elements: graphic title, without 
dividing lines, vertical axis title, horizontal axis title, legend (s). The typography for graphics will 
be the one used for the writing, in bold font, size of 10 points and the first letter in capitals. If the 
graphical representations are results from statistical analyses, consider the following items 
according to each case: Means, standard errors and deviations, which should be shown with their 
associated sample sizes as follows: “Mean ± Standard Error = 24.0 ± 3.1 ml, N = 62”. For 
Significance tests, provide names, test statistics and their value, freedom degrees or sample size 
and the value of P, all separated by commas “Mann-Whitney U test, U = 43, N1 = 4, N2 = 17, P = 
0.05”. Tests where freedom degrees are presented as ANOVA should display values of F = 5.72 
and P = 0.01. In case of handling confidence intervals and different groups within the graph, it is 
necessary to define these by means of different letters, as well as to add the values of F and P (level 
of significance) within the area of the graphs (Fig. 3). The graphics should be sent in an editable 
format (Excel or similar) and inserted within two lines of a 1X2 table as in the case of the tables. 
The graphics will be accepted only in gray scale in order to have uniformity and formality. The size 
of the graph should fit a rectangular area of 12 X 19 cm. The typography of the graphic will be 
Times New Roman; main title must centered at 18 points, vertical and horizontal axis titles as well 
as the series at 12 points and in bold fonts. The scales of vertical and horizontal axis must be in bold 
fonts and 12 points. The area of the graphics must not include dividing lines and according to the 
type of graph, respective values must display within the same area. 
 

 
Graph 1. Basic elements of a typical graph. The type may vary according to the analysis 
performed as well as the values and essential elements. 
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Images. Both photographs, figures or drawings of schemes that represent direct information of the 
contribution and that are considered novel in the scientific field are accepted. They need to be clear, 
clear in explanation, of good quality and complete without maximizing or minimizing them to avoid 
deformation. These must be presented in the text of the body in a 1X2 table (Fig. 2) by means of the 
INSERT menu of the Table submenu (Figure 2.) Once this table is shown that appears as two lines, 
we proceed to place title (line lower) and figure (upper line). The images are accepted in PNG or 
JPG format at a minimum resolution of 350 dpi, with a minimum size of 530 x 1300 pixels and 
centered on the top line. Equations are also considered here if necessary, however they should be 
written using MathType (not images). The text of the title is respective to the general format of the 
contribution. Graphics converted to images will not be accepted because these prevent editing 
process. The images must be sent within the document below to where these are mentioned. When 
these are microscopy or stereoscopic images it is recommended to send them in grayscale, as well 
as to include technical data of the photograph such as scale, magnification at which it was taken and 
detail marks (Fig. 4). 
 
 

 
Image 1. Example of the details to consider for images such as scale (lower part), technical 
characteristics (lower part) and details to be highlighted (white line, right part). 
 


